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1. Microsoft Access 2007 – Overview

a. What is it?

Access 2007 is the latest and greatest database development application from Microsoft. It is one of the many software programs that make up MS Office 2007 which is available only for the Windows PC operating system.  It is used for creating basic letters to more complex documents like newsletters, manuals, forms, and now blogs

b. Previous versions:

i. Windows PC: Office 2003 – is compatible with 2007 if the updated compatibility package is downloaded and installed

http://office.microsoft.com/en-us/products/HA101686761033.aspx
ii. Apple Mac: there is no previous version of Access for the Mac 

c. It is recommended that during the installation of Office 2007 you also uninstall your older version(s) of Office. Although you can have multiple versions installed at the same time you will encounter problems. The most noteworthy issue is trying to open two versions of one program. For instance, if you open both Word 2003 and Word 2007, then restart your computer you will find that Word will not open right away. In fact, your computer will need to reinstall upon trying to open Word 2003 or Word 2007 taking a considerable amount of time
2. Creating and Saving databases
a. What is this?

A database can be as basic as a contact list or as complex as an entire organization’s infrastructure and operations
b. When opening Access 2007 it automatically prompts you to choose how you want to start

i. Creating

1. New Blank  Database
a. A way to start from scratch where the file has no existing data or objects

2. Templates
a. Either featured online or local, templates have pre-existing setup information that will help you with organization and efficient database development

ii. Choose Blank Database
1. To the right a new column will appear

2. Click the folder icon under File Name:
a. In the new window select My Documents as the location to save

i. This is the default location to save

ii. This is the best choice to save all of your files as it is easy to back up this folder

iii. You can also make folders within the My Documents folder for better organization
b. Name the file, sfsu_students.accdb
iii. Saving
1. You should save the file as a Microsoft Office Access 2007 Database file (.accdb)
a. This is not compatible with older versions unless the compatibility package was installed on the computer that tries to open the file
2. If you wanted to open this file on an older version without using the compatibility package then you must save the file as an older (.mdb) file format

3. Click the OK button

4. In the column to the right under File Name: click the Create button

iv. Auto save
1. From now on Access will automatically save your file when you make changes
3. The new Office 2007 interface

a. What is this?

Known as a Graphical User Interface (GUI) it uses windows, icons, pull-down menus, and the mouse to make using the program easier to learn and work with

b. Title bar

i. File name, format, mode, application

c. Quick Access Toolbar

i. Save, Undo, redo, and the toolbar is completely customizable

d. The Office button

i. Similar to the Access 2003 File menu

ii. New, Open, Save, and so on…

1. Those with arrows have additional commands you can choose

iii. Buttons in bottom right

1. Access Options
2. Exit Access
e. The Office Ribbon

i. Biggest interface change from previous versions

ii. Home, Create, External Data, Database Tools, and so on…

iii. The Ribbon is context sensitive

1. It may change depending on what you do
2. Right now you should see a section named Table Tools with a tab named Datasheet
a. This tab is used when working on a table 
iv. Each tab has a number of groups

1. When you hover your mouse pointer over a group item information will typically appear

v. In the bottom right of some group panels you’ll find a little diagonal arrow

1. Click to launch a new window for more options and choices within that group

vi. The Help button (circle w/ a question mark inside) is located above and to the right of the Ribbon

1. Once selected a new Access Help window appears

a. Help Categories

i. Select any Topic under Browse Access Help to find more helpful Subtopics

b. Help Search

i. Click inside the textbox, type a topic, and click Search
2. You can also navigate and find other helpful options (like Home and Print) on the toolbar located near the top of the Help window

vii. Keyboard shortcuts

1. The Alt key turns on all visible shortcuts (numbers and letters)

2. Next, press the keyboard key with the letter or number that represents what you want

3. Then you’ll see that the groups within that choice now have shortcuts showing so you can choose the specific option within

4. The Alt key turns off all visible shortcuts as well

viii. Minimize/Maximize the Ribbon

1. Right-click on any tab or tab group and select Minimize the Ribbon
4. Views
a. What are these?
Access 2007 uses different views when you are creating or editing parts of your database. Each view offers specific options that will help you design and develop
b. Change views

i. On the Ribbon and the Status Bar (bottom right)

1. On the Ribbon, select the Home tab > in the Views group > select View (down arrow) > Design View
2. In the new Save As window, save your table using the name students
3. Click the OK button

c. On the Ribbon you are now working within the Design tab

d. New to Access 2007 is the column to the left
i. This column shows your database view, in that you can see any and all objects to work with

ii. You can change what you view in this column by clicking on the button at the top of the column

e. Directly below the Ribbon and to the right of the database/objects view column is your table (students) tab

i. Underneath is where you will define the fields used in your table

ii. Underneath that is the Field Properties window where the field properties are set
5. Create a field
a. What are these?
A table contains data about a particular subject, such as employees or products. Each record in a table contains information about one item, such as a particular employee. A record is made up of fields, such as name, address and telephone number. A record is also commonly called a row, and a field is also commonly called a column
b. Create a unique field
i. New to Access is the automatically generated ID field

1. This field is already your primary key
a. The primary key of a table consists of one or more fields that uniquely identify each row you store in the table. Often, there is a unique identification number, such as an ID number, a serial number, or a code, that serves as a primary key. For example, you might have a Customers table where each customer has a unique customer ID number. The customer ID field is the primary key of the table
b. To assign/remove a primary key

i. On the Ribbon > select the Design tab > in the Tools section > click Primary Key
c. Keep this field as your primary key

2. Under Field Name, name this field: sid
a. This is your student ID # field

3. Under Data Type, choose a type
4. Under Data Type, choose a type*

a. *At the end of this document is a table that describes the data types available for fields
b. The Data Type to choose for this field is Text
6. General field properties

a. What are these?
You can control the appearance of information, prevent incorrect entries, specify default values, speed up searching and sorting, and control other appearance or behavior characteristics by setting field properties
b. Setup the field properties
i. In the Field Properties area, select the General tab
ii. To the right of Field Size, type 11

1. Field size is the maximum amount of characters that is needed for the field for every record

iii. Click inside the Input Mask text box and then select the button that appears to the right 

1. An Input Mask Wizard window will appear
2. Input masks control how users enter data into a database. For example, an input mask can force users to enter telephone numbers in the Swedish format or addresses in the French format
3. Select Social Security Number and then select the Next button

4. The next section of the wizard should show 000-00-0000
a. 0 means that the user must input a number only

b. You can change this manually if you want
5. Select the Next button

6. How do you want to store the data?

a. Select the radio button to the left of, With the symbols in the mask, like this:
7. Select the Next button

8. Select the Finish button

9. Click inside the Caption textbox and in the Input Mask textbox you should now see 000\-00\-0000;0;_
iv. In the Caption textbox type, Student ID # 

1. The Caption you input will appear at the top of the field column when enter your data

2. A good caption helps you know what you are supposed to input

v. In the Required textbox type, Yes 

1. This is the option like you see on web forms where you have to enter the information before moving on to the next step. Same thing here where you cannot move on to the next record unless the correct information and format is entered

vi. In the Allow Zero Length textbox type, Yes
You can set Text or Memo fields to a zero-length string to indicate that the value of a field is known but the field is empty. You can join tables on zero-length strings, and two zero-length strings will compare to be equal. However, for Text, Memo, and Hyperlink fields, you must set the Allow Zero Length property to Yes to allow users to enter zero-length strings. Other-wise, Access converts a zero-length or all-blank string to a Null before storing the value. If you also set the Required property of the Text field to Yes, Access stores a zero-length string if the user enters either "" or blanks in the field.

Why is it important to differentiate Nulls from zero-length strings? Here’s an example: Suppose you have a database that stores the results of a survey about automobile preferences. For questionnaires on which there is no response to a color-preference question, it is appropriate to store a Null. You don’t want to match responses based on an "unknown" response, and you don’t want to include the row in calculating totals or averages. On the other hand, some people might have responded "I don’t care" for a color preference. In this case, you have a known "nothing" answer, and a zero-length string is appropriate. You can match all "I don’t care" responses and include the responses in totals and averages.

vii. In the Indexed textbox you should have Yes (No Duplicates)
1. This will speed up searches and sorting
2. This will also create a larger file size and may bog some databases down

3. Choose Index only if you feel you will search and sort often in this field
c. Create fields

i. New field:

1. First Name

a. Field Name: fname
b. Date Type: Text
c. Field Properties:

i. Field Size: 25
ii. Caption: First Name
iii. Required: Yes or No  (your choice)
iv. Allow Zero Length: Yes or No  (your choice)

v. Indexed: No
2. Last Name

a. Field Name: lname
b. Date Type: Text
c. Field Properties:

i. Field Size: 35
ii. Caption: Last Name
iii. Required: Yes or No  (your choice)

iv. Allow Zero Length: Yes or No  (your choice)

v. Indexed: No
3. Street Address

a. Field Name: address
b. Date Type: Text
c. Field Properties:

i. Field Size: 35
ii. Caption: Street Address
iii. Required: Yes or No  (your choice)

iv. Allow Zero Length: Yes or No  (your choice)

v. Indexed: No
7. Lookup wizard
a. What is this?
A multivalued lookup column is a field in a table whose values are retrieved from another table or from a value list. Using a multivalued lookup column, you can display a list of choices in a combo box or list box. The choices can be supplied by a table or query, or they can be values that you enter. Because the lookup column is multivalued, you can choose more than one item in the list
You can create a multivalued lookup column manually by setting a field's Lookup field properties, or automatically by completing the Lookup Wizard. Whenever possible, you should use the Lookup Wizard to create a multivalued lookup column. The Lookup Wizard simplifies the process and automatically populates the appropriate field properties and creates the appropriate table relationships
b. Create a field that uses the Lookup Wizard
i. New field:

1. City

a. Field Name: city
b. Date Type: Lookup Wizard...
i. In the new Lookup Wizard window

1. Select the radio button to the left of, I will type in the values that I want.
2. Click the Next button

3. In the textbox under Col1 type the first value listed below, and then tap the Tab key, type the next value, and so on...

a. San Francisco
b. Daly City
c. Oakland
d. Pacifica
4. Click the Next button

5. Click the Finish button
c. Field Properties:

i. Field Size: 35
ii. Caption: City
iii. Required: Yes or No  (your choice)

iv. Allow Zero Length: Yes or No  (your choice)

v. Indexed: No
8. Format, default value, and more input mask
a. What is this?
A variety of different field properties that can change the way you interact with your fields while entering in your record data
b. Create a field that uses a specific Format  and a Default Value
i. New field:

1. State

a. Field Name: state
b. Date Type: Text
c. Field Properties:

i. Field Size: 2
ii. Format: >
1. Using the > symbol means that any data that is entered in this field will be capitalized
iii. Caption: State
iv. Default: CA
1. In using this, each record will automatically have the value CA for State
2. Note: the value CA will change to “CA” once you click inside another property textbox
v. Required: Yes or No  (your choice)

vi. Allow Zero Length: Yes or No  (your choice)

vii. Indexed: No
c. Create a field that uses a the Input Mask
1. Challenge the class to use the same process they learned previously when they created the Student ID. The Input Mask should always be used for Zip Code
2. Zip Code

a. Field Name: zcode
b. Date Type: Text
c. Field Properties:

i. Field Size: 10
ii. Click inside the Input Mask text box and then select the button that appears to the right 
1. If you are prompted to save the table, then choose Yes
2. An Input Mask Wizard window will appear
3. Select Zip Code and then select the Next button

4. The next section of the wizard should show 00000-9999   
a. 9 means that the user may input a number only

b. You can change this manually if you want
5. Select the Next button

6. How do you want to store the data?

a. Select the radio button to the left of, With the symbols in the mask, like this:
7. Select the Next button

8. Select the Finish button

9. Click inside the Caption textbox and in the Input Mask textbox you should now see 00000\-9999;0;_
iii. Caption: Zip Code
iv. Required: Yes or No  (your choice)

v. Allow Zero Length: Yes or No  (your choice)

vi. Indexed: Yes (Duplicates OK)
9. Validation rule
a. What is this?
A validation rule limits or controls what users can enter in a table field or a control (such as a text box) on a form. Microsoft Office Access 2007 provides a number of ways to validate data, and you often use several of those techniques to define a validation rule
b. Create a field that uses a Validation Rule
i. New field:

1. Gender
a. Field Name: gender
b. Date Type: Text
c. Field Properties:

i. Field Size: 1
ii. Format: >
iii. Caption: Gender
iv. Validation Rule: 

1. Click inside the textbox and then click on the Wizard button that appears to the right

2. Input this rule: F Or M Or B
a. This means one of these three values must be entered. Nothing else will be accepted

v. Validation Text: Please enter an F, M, or B only 
1. This message will appear when the wrong value is entered

vi. Required: Yes or No  (your choice)

vii. Allow Zero Length: Yes or No  (your choice)

viii. Indexed: No
c. Create a description

i. A description helps you describe the field and is also displayed in the status bar when you select this field on a form (forms will be covered in the Access II class)
ii. Click inside the textbox to the right of the gender field Data Type and under the column header Description
iii. Type: F = female, M = male, B = bi
10.  Lookup wizard challenge
a. What is this?
A class challenge to create another multivalued lookup column for a field whose values are retrieved from a value list. 
b. Challenge the class to create a field that uses the Lookup Wizard with these 8 college values and 1 missing value

i. Humanities
ii. Business
iii. Science
iv. Creative Arts
v. Education
vi. Ethnic Studies
vii. HSS
viii. BSS
ix. Other
c. After the challenge is complete, demonstrate how they should have created the field 

i. New field:

1. College

a. Field Name: college
b. Date Type: Lookup Wizard...
i. In the new Lookup Wizard window

1. Select the radio button to the left of, I will type in the values that I want.
2. Click the Next button

3. In the textbox under Col1 type the first value listed below, and then tap the Tab key, type the next value, and so on...

a. Humanities
b. Business
c. Science
d. Creative Arts
e. Education
f. Ethnic Studies
g. HSS
h. BSS
i. Other
4. Click the Next button

5. Click the Finish button
c. Field Properties:

i. Field Size: 14
ii. Caption: College
iii. Required: Yes or No  (your choice)

iv. Allow Zero Length: Yes or No  (your choice)

v. Indexed: No
d. Limit the values to the list
i. In doing this only the values in the list can be entered, anything else will not be accepted

ii. Select the Lookup tab

iii. To the right of Limit To List choose Yes
11.  Yes/No data type
a. What is this?
You can set the Data Type to the Yes/No, which essentially is a True/False, or On/Off predefined format 
b. Create a field that uses the Yes/No data type
i. New field:

1. Financial Aid

a. Field Name: faid
b. Date Type: Yes/No
c. Field Properties:

i. Caption: Financial Aid
ii. Default Value: [blank]
iii. Indexed: No
12.  Fields with numeric value
a. What is this?
You add a Number field to a table when you need to store numeric data, such as sales figures. Numbers that have no numeric value should be treated as a Text data type 
b. Create a new field that uses has numeric value
i. New field:

1. Credit Hours

a. Field Name: chours
b. Date Type: Number
c. Field Properties:

i. Field Size: Integer
1. [Byte]: is used to store numbers 0 through 255. [1 byte] 

2. [Integer]: is used to store numbers   -32,768 through 32,767. [2 bytes] 

3. [Long Integer]: is used to store numbers -2,147,483,648 through 2,147,483,647. [4 bytes] 

4. [Single]: real/fractions represented with scientific notation with at least 6 digits of accuracy. [4 bytes] 

5. [Double]: real/fractions represented with scientific notation with at least 12 digits of accuracy. [8 bytes]

ii. Caption: Credit Hours
iii. Default Value: [blank]
iv. Required: No
v. Indexed: No
2. Quality Points

a. Field Name: qpoints
b. Date Type: Number
c. Field Properties:

i. Field Size: Integer
ii. Caption: Quality Points
iii. Default Value: [blank]
iv. Required: No
v. Indexed: No
13.  Create records
a. What are these?
Each record in a table contains information about one item, such as a particular employee. A record is made up of fields, such as name, address and telephone number. A record is also commonly called a row, and a field is also commonly called a column
b. Change view
i. On the Ribbon, (in the Table Tools section) in the Design tab > in the Views group > select View (down arrow) > Datasheet View
ii. Save the table if necessary

c. Create six student records

i. Type in values for each field for all six records
ii. You can move forward from field to field by using the Tab key on your keyboard
iii. You can move backward by holding the Shift key down, and taping the Tab key 

iv. You can make selections from the drop down menus by typing the first letter of the city in the list and then taping the Tab key
v. The space bar will select the radio button (circle) of your choice in the Yes/No Financial Aid field
d. How many records?

i. In the bottom left corner of the datasheet entry window you should see Record: 
1. You will see # of #, which indicates the record you are currently working with and the total number of records

2. Use the arrow to navigate through your records
14.  Sorting records
a. What is this?

Data whether it be text or numbers can easily be arranged or sorted in ascending or descending order 
b. Sort your records
i. To sort alphabetically by name move your mouse pointer inside the field caption Last Name
1. Move the Last Name column

a. Click once and let go

b. Click inside again but don’t let go this time

c. Move your mouse pointer (drag the column) so that it is before the field column First Name
d. Let go of your mouse click

2. Select both name fields

a. Click inside any cell of any record

b. Click and hold down inside the Last Name field caption

c. Drag your mouse pointer into the First Name field caption (thus selection both name columns)

3. Sort the records

a. On the Ribbon, (in the Table Tools section) in the Datasheet tab > in the Sort & Filter group > select Ascending ([image: image1.jpg]


)
15.  Create a backup
a. What is this?

A backup is a copy of the original file. This is extremely beneficial if the original file is either damaged or lost
b. Close Access

c. Save the table or layout if necessary

d. Open your My Documents folder for your new database file

e. Create a backup

i. Move your mouse pointer into the file icon

ii. Right-click

iii. From the menu choose Copy
iv. Move your mouse pointer to an empty area inside the folder

v. Right-click

vi. From the menu choose Paste
vii. Rename the file, sfsu_student_[date].aacdb
16.   Open floor for Q&A

17.  Next week - Access II – Intermediate Topics

a. To be determined!
The following table describes the data types available for fields in Office Access 2007.
	Data type
	Stores
	Size

	Text
	Alphanumeric characters 

Use for text, or text and numbers that are not used in calculations (for example, a product ID).
	Up to 255 characters.

	Memo
	Alphanumeric characters (longer than 255 characters in length) or text with rich text formatting. 

Use for text greater than 255 characters in length, or for text that uses rich text formatting. Notes, lengthy descriptions, and paragraphs with formatting such as bold or italics are good examples of where you would use a Memo field.
	Up to 1 gigabyte of characters, or 2 gigabytes of storage (2 bytes per character), of which you can display 65,535 characters in a control.

	Number
	Numeric values (integers or fractional values). 

Use for storing numbers to be used in calculations, except for monetary values (use the Currency for data type for monetary values).
	1, 2, 4, or 8 bytes, or 16 bytes when used for replication ID.

	Date/Time
	Dates and times. 

Use for storing date/time values. Note that each value stored includes both a date component and a time component. 
	8 bytes.

	Currency
	Monetary values. 

Use for storing monetary values (currency).
	8 bytes.

	AutoNumber
	A unique numeric value that Office Access 2007 automatically inserts when a record is added. 

Use for generating unique values that can be used as a primary key. Note that AutoNumber fields can be incremented sequentially, by a specified increment, or chosen randomly.
	4 bytes or 16 bytes when used for replication ID.

	Yes/No
	Boolean values. 

Use for True/False fields that can hold one of two possible values: Yes/No or True/False, for example.
	1 bit (8 bits = 1 byte).

	OLE Object
	OLE objects or other binary data. 

Use for storing OLE objects from other Microsoft Windows applications.
	Up to 1 gigabyte. 

	Attachment
	Pictures, Images, Binary files, Office files. 

This is the preferred data type for storing digital images and any type of binary file.
	For compressed attachments, 2 gigabytes. For uncompressed attachments, approximately 700k, depending on the degree to which the attachment can be compressed. 

	Hyperlink
	Hyperlinks. 

Use for storing hyperlinks to provide single-click access to Web pages through a URL (Uniform Resource Locator) or files through a name in UNC (universal naming convention) format. You can also link to Access objects stored in a database.
	Up to 1 gigabyte of characters, or 2 gigabytes of storage (2 bytes per character), of which you can display 65,535 characters in a control.

	Lookup Wizard
	Not actually a data type; instead, this invokes the Lookup Wizard. 

Use to start the Lookup Wizard so you can create a field that uses a combo box to look up a value in another table, query or list of values.
	Table or query based: The size of the bound column. 

Value based: The size of the Text field used to store the value.
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